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1 Introduction and Background 

Seatrack Web is developed at SMHI in close cooperation with the Danish Maritime 
Safety Administration, Bundesamt fur Seeshifffart und Hafen and the Finnish 
Environment Institute. The first version of Seatrack Web was introduced in 1995 and 
since then Seatrack Web has been used successfully in several oil spill cases. It is also 
developed further to be a well functioning tool for authorities responsible for oil spill 
response in the Baltic Sea region. 

Seatrack Web’s main purpose is to calculate the spreading of oil that has come out in 
the Gulf of Bothnia, the Gulf of Finland, the Baltic Sea, the Sounds, the Kattegat, the 
Skagerack and part of the North Sea (out to 3 E). The program can also be used for 
other substances than oil, such as chemicals, algae and objects.  

In addition to an oil drift forecast, it is possible to make a backward calculation. Then 
a calculation starts at the position where a substance was found. The programme 
calculates the drift backwards in time and traces the origin of the substance or an 
object. 

1.1 The circulation model 

When you login at SMHIs Seatrack Web you have access to forecasted current fields 
of the Hiromb model (HIgh Resolution Operational Model for the Baltic ), which is a 
3-dimensional circulation model covering the whole Baltic Sea and part of the North 
Sea. The forecasts are made daily and up to 5 days forecasts are included into Seatrack 
Web. Every 3rd hour new current fields are used in Seatrack Web. 

The horizontal grid resolution is now either 1 or 3 nautical miles giving current values 
at every 1 or 3 nm. In Seatrack Web the forecasted surface currents (0-4 m) can be 
plotted for 3 nm Hiromb gives the currents at 50 different depth levels and those 
influence the drift and spreading of the substance. 

1.2 The weather models 

The wind forecasts used in Seatrack Web originate from the weather model at the 
European Centre for Medium-Range Weather Forecasts (ECMWF) 5 days ahead and 
HIgh Resoluted Limited Area weather Model (HIRLAM 11km) 2 days ahead. The 
wind forecasts used in Seatrack Web are from 10 meters height. The user should be 
aware that smaller scale and local wind effects are not included into the Seatrack Web 
drift calculations. The forecasted wind can be plotted. 

1.3 Ice information 

Ice and oil interaction was introduced in Seatrack Web during 2005. The user may 
select the Ice layer and see the ice cover in the Baltic Sea. The accuracy of the 
forecasted ice cover is enhanced by daily assimilation of ice observations into the 
Hiromb model.  
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2 Installation of Seatrack Web 

2.1 System Requirements 

PC-compatible Pentium 700 MHz 
2 Mb video-memory,  
17’’(1024x768) screen, 
256 Mb RAM, 
Use Internet Explorer, minimum version 7.0. 
Make sure to always use the latest Java version. 

Internet connection is needed and should be as fast as possible. A reasonable transfer 
speed is minimum 256 kilobit/sec. 

2.2 Enter the Internet address 

Enter the Internet address http://www.smhi.se/seatrack in your Web browser. 

2.3 Installation of Java Web start 

This version runs via 'Java Web start'. This means that the Seatrack application now is 
installed once and automatically updated when needed. When clicking start above 
when 'Java Web start' is not installed on your computer you will be redirected 
automatically to Sun's download site for Java Web start. Follow the instructions, 
installing Java Web start only needs to be done once. 
 

 

If this is your first visit on http://www.smhi.se/seatrack you will be redirected to 
(when pressing ’Start Seatrack’) 
http://java.sun.com/products/javawebstart/needdownload.html (picture above). 

If the redirection to 'Java Web start' download site does not work automatically, use 
the link http://java.sun.com/products/javawebstart/needdownload.html to download 
Java Web start manually.  

 

- Press ’Download Now’.  
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- Select ‘Download J2SE 5.0 JRE/SDK’ 

- Select ‘Download JRE 5.0 Update 5’ or any newer update version number   

- Choose from the list of platforms to download the installation package 

2.4 How to make proxy settings in Java Web start 

1. Start Java Webstart from the icon on your desktop or from the start menu. 
2. Choose "File" and "Preferences", if nothing is happening, please wait…. 
 

 
 
3. … preferences dialog should appear on screen: 

 

Change the proxy settings to your server and port, also add server exceptions if you 
have any, then press OK. 
4. Quit Java Webstart 
5. Restart the computer 
6. Start Seatrack. 
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2.5 To look at the java console to know what is going wrong 
1. Choose File Explorer (Utforskaren) and go to the file where the java program is 
installed on your system  
   Example paths: 
   C:\Program\Java\jre1.6.0_02\bin 
   C:\Program\Java\j2re1.4.2_05\javaws 
   C:\Program Files\Java\jre1.5.0_03 
   Could be any other path depending on where you initially installed java. 
 
2. Double-click on javaws.exe, and the Java Web Start – application manager (- 
programhanterare) starts  
 
3. Go in below 'File -> Settings' or 'Edit -> Settings' (Inställningar) 
 
4. Choose Advanced (Avancerat) 
 
5. Click in Show (Visa) Java-system window (Java-console) and press OK, Ready! 
 
Alternative 2-4, instead of 2-5 above. 
2. Double-click on javacpl.exe and you come to Java control panel 
 
3. Choose Advanced (Avancerat) 
 
4. Click on Java consol and choose Show consol, press Apply (Tillämpa) and then 
OK. 
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3 Start and Stop Seatrack Web 

3.1 Start 

Enter the Internet address, which is http://www.smhi.se/seatrack in your Web browser. 

The manual is found by clicking ‘User manual’. Also ‘Technical Documentation’ is 
here. For support, click ‘Contact’, figure 1. 

Press ‘Start Seatrack Web’, write User and Password, press Login and the map in 
Figure 2 appears. 

 

Figure 1.The Seatrack Web start page with Seatrack user news. 

3.2 Stop 

If you want to stop Seatrack Web, go to ‘File’ and click ‘Exit’. 
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4 The graphical user interface 

 

Figure 2. Map over the area. 

4.1  Menues in the upper frame 

The menu in Seatrack Web is similar to the windows system, with some choices at 
the top of the screen. At the top frame are File, View, Layer and About. 

 

File gives the following options:  
Open Case- when you want to open an existing calculated case.  
Save Case- when you want to save a calculated case. When Save is done you choose 
the directory yourself. The name of the case must have suffix .xml if you have Java 
1.6 or higher.  
Save Map as image – saves the map in a jpg format. 
Email map image - mails the map. 
Read Bohuslan info - especially for a Swedish application. 
Download Bohuslan data - especially for a Swedish application. 
Change password 
Load AIS data – especially for those having access to AIS data 
Clear AIS data - especially for those having access to AIS data. See Annex 1. 
Load algae data – a special file processed at SMHI from satellite detections of algae. 
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Example of algae data detected from satellite 

Clear algae data 

Satellite detections of oil spills, see Annex 2 

Exit  

View gives the following options:  
Available files – HIROMB 3 nm, 2 days forecast, HIRLAM (every 6 hour) shows 
which period you can make an oil drift forecast with HIRLAM. Forecasted currents 
and winds are generated every third hour and available 30 days back in time from 
today at 00.00.  
Available files – HIROMB 3 nm, 5 days forecast, ECMWF (every 12 hour) shows 
which period you can make an oil drift forecast with ECMWF. Forecasted currents 
and winds are generated every third hour and available 30 days back in time from 
today at 00.00.  
Available files – HIROMB 1 nm, 2 days forecast, HIRLAM (every 12 hour) shows 
which period you can make an oil drift forecast with HIRLAM. Forecasted currents 
and winds are generated every third hour and available 30 days back in time from 
today at 00.00. 
AIS information, see Annex1. 
Available AIS data files 
AIS ships 
Ship info 
Input data shows what parameters you have chosen for the calculation. 
Results table shows weathering properties, volume, viscosity, density, wind and 
current data. They can be plotted automatically by your own choice. 
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Layer, Show/hide layer selection gives the following options 

   
 

 

When this check box is selected a label for each selected layer is shown.  
 

Name & Time & Layer description means the grey square in the upper left corner of 
the map, showing the name of the calculation, the time it is made and the time of the 
result, see below. 
Static layers 
Graphics, makes it possible to draw green lines anywhere in the map 
Lat/lon grid,  plot the latitude and longitude grid 
Boundary for Territorial waters , shows this border for all countries 
Base line, shows this border along the Swedish coast 
Bridges, the Öresound bridge and the bridge to Öland 
Cities and countries, names 
Danish economic zone 
Maris response zones, ‘Exclusive Economic Zone (EEZ)’ information based on the 
Maritime Accident Response Information System (MARIS) in HELCOM 
http://www.helcom.fi/gis/maris 
Bohuslan area, especially for a Swedish application 
Country borders 
Baltic Sea Protected Areas, BSPA 
Important Bird Areas , IBA 
Major ship routes 
Ship traffic separation 
 
Dynamic layers 
Satellite outlet plot  
Hiromb coastline, plot the outer border of the model’s grid  
Hiromb Depth, coloured depth information. 
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About 
About Seatrack Web   
Credits to people 

4.2  Tool buttons for controlling the map view and starting a 
calculation 

 

Arrow  shows an arrow where the cursor is.  
Zoom is a zooming tool, it is important that the area chosen has the cursor/cross in the 
lower right corner and not further down in the map. Otherwise another area is zoomed. 
Center symbol gives the possibility to move the map on the screen, where you put the 
symbol, the new center will appear 
Zoom in gives one step zoom every time you click in the map 
Zoom out gives one step zoom out for every click in the map 

 Maximize scale in current window, gives the whole map back. 

 Set map scale, choose your own scale and center point, Scale, Center (lower left) 
shows your scale and centre point. If you later want to have the same map area. 

 Add, edit or delete text on map, the text can be moved in the map 
 
Draw lines draw a green line, take away by doubleclick 
Distance shows the distance in nautical miles and bearing (angle measured clockwise 
from north) below the map. You stop this by a double-click 
Show/hide layer selection open/close the window with the GIS layers. 

Model choice, Hiromb model 3 nautical miles, choose between 5 days forecast or 2 
days forecast or Hiromb model 1 nautical mile 2 days forecast. 

 

 

New Case, go to the Calculation Parameters. See figure 3. 

Continued Case, continue a calculation, which is made before. A default stop time is 
suggested, giving one more day, it can be changed, check that data exist below View. 
You can also continue a calculation that has been made earlier and saved in Save case 
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below File, then go to File and press Open Case. You are asked where the saved file 
is, and copy it to STW. 

Make outlet, the red star is default in the cursor, when starting a calculation. Choose 
Point (1 position), Line (2-4 positions) or Area (3-4 positions). Fetch the red star 
symbol when you want to mark the outlet position. Doubleclick to give the outlet 
positions. It is possible to move the corners of the spot with the mouse. 
If you click more points then you have chosen, the positions are deleted. 

The rest of the buttons in the upper frame are active when you have a calculated case. 

Delete case, a cross, return to default settings when a calculation is made. 

Position information (lower left) you can see any position when moving the cursor in 
the map.  

Scale, Centre (lower left) shows your scale and centre point of the map. 

5 Choose calculation parameters and start a calculation 

5.1 Time & Position 

 

Figure 3. Kind of calculation, start and stop time, start positions and outlet depth. 

Forward calculation, make a forecast up to 5 days ahead and start 30 days back in 
time. Here you can see which models you have chosen. Default of Stop time is always 
tomorrow at 24.00 UTC even though there are more days, this is changed manually. 
Start time is always present time UTC, Coordinated Universal Time.  

Backward calculation, make a calculation backwards in time, to find the place where 
the oil or object comes from. The Start time now has to be ‘later’ than the Stop time. 

Start position is given as degrees, minutes and decimals of minutes. 
OBS, not minutes and seconds. If you have clicked this directly in the map, it is 
shown here. You can change here if needed. 

If you make a dot, line, triangle or square then some of the points can be on land if at 
least one of them is situated in the sea, see Figure 4. 
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Figure 4. Outlet specified by a triangular area which partly covers land. 

Outlet depth is the initial depth of the spill. The depth is given in meters, decimals are 
possible.  

5.2 Substance 

In Oil classes there are 3 different viscosity intervals, Light, Medium and Heavy oils. 
A choice here is recommended if one does not have information about the oil type. See 
fig. 5. Choosing one of these gives the default values among the Oils specific below 
Light: Light Diesel Fuel  
Medium: Intermediate Oil  
Heavy: Bunker C. 

Figure 5. Choice of viscosity range. 

Below State of oil you have to select state, if it is new oil choose Fresh oil, but if the 
oil has been in the water for some time, choose Weathered oil. Evaporation and 
emulsification has stopped at the maximum value for Weathered oil. 
Below Oil, specific there are first 11 specified oils to be chosen. Most of those are oil 
ranges (many different oil types), but it is more specific then Oil classes. This is a 
possibility, when one has more information about the oil. Choose State of oil.  
When Rebco oil is wanted choose Light-Medium Crude. 
Three oils emulsify: Light-medium crude, Heavy crude and Bunker C. 

2 new heavy oils are introduced in a test phase, Orimulsion (test) and High Viscosity 
Fuel Oil (test). The knowledge about these oils is limited, and weathering processes 
are not activated. The densities are fixed to 1020 kg/m3 (Orimulsion) and 1015 kg/m3 

(High Viscosity Fuel Oil). 
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Below those oils there are 25 oils from Sintef’s Oil Weathering Model. All emulsify 
except Sleipner (IKU) and Marine Diesel (IKU).  
Balder (medium), Ekofisk Blend (medium), Grane (medium), Gullfaks (light), Kristin 
(light), Norne (medium), Oseberg A (light), Sleipner (light), Statfjord A (light), Ula 
(light), Valhall (light), Aasgard (light), DUC (light), Siri (light), South Arne 
(medium), Fuel oil no 6 LS (heavy), IF-180 (heavy), IF-380 (heavy), IF-30 Bunker 
(medium), Marine diesel (light), IFO 380 Fu Shan Hai (heavy). 

Oil lumps give 5cm, 10cm or 20cm thickness of the oil from the surface and 
downwards. 

Floating object / Algae  
Floating algae behaves like a Floating object with ‘0 % extra wind drag on object’. 
Floating algae, file is described above. 
Floating object with extra wind drag, an object can be partly above the water 
surface. It is possible to add extra wind drag for the part above the water surface. See 
Wind drag %  

 

Objects/substance can be calculated at a Constant depth or Three dimensional 
spreading as a passive tracer. 

5.3 Discharge 

Instantaneous spill, the Amount is m3 or tonnes. Decimals can be used e.g. 5.7 m3. 

Continuous spill Total amount/Rate. Decimals can be used e.g. 0.4 m3/hour. 
Duration  of the spill is given in days or hours. 

5.4 Scenarios 

 

If you want to make scenarios (which has nothing to do with reality), you choose 
Scenarios with prescribed currents and winds. The time period that is shown in the 
window is the same as at Time & Position. 
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The user fills in the current and wind every hour or at time steps of one’s own choice. 
Then by pressing FILL, the hours below the written data are filled with the nearest 
above information. This gives a possibility to write new currents at fewer time steps 
than every hour.  

The Current speed (knots) is the speed in knots. Current Direction (degrees 
towards) is the direction measured clockwise from north (90 degrees means currents 
towards east, 180 degrees means currents towards south etc.). Note that the prescribed 
current will be the same at all locations and at all depths, but varies in time.  

The Wind speed (m/s) is the speed in m/s. Wind Direction (degrees from) is the 
direction measured clockwise from north (90 degrees means wind from east, 180 
degrees means wind from south etc.). 

Choose CLEAR to erase all data and then give new ones. 

To account for the uncertainty in the weather forecast the user can select Add 
uncertainty which depends on uncertainty in the weather forecasts. When this 
option is selected the area over which the oil (or substance) is spread during the 
calculation will increase to reflect the possible spreading of the spill when the 
uncertainty of the weather forecast is included. Hence, the increased spreading should 
not be interpreted as a physical process, but as a consequence of the inherent 
uncertainty in the weather forecast.  

5.5 Calculation options 

Calculation mode gives the possibility to choose Brief:  100 particles, Normal:  500 
particles or Detailed: 2000 particles. Sometimes one just needs a forecast very fast 
then Brief is recommended. At other occasions a very high significance is needed and 
then many particles will improve the result. This choice, though, can take quite a long 
time to calculate. Normal is the default value. 

5.6 Calculation info 

 

Calculation name is the name you want to call the case. This is later written in the 
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grey square in the upper left corner of the map. Other info is of your own choice, but 
is useful when you want to save the picture of the Calculation parameters by choosing 
View and Input data. 

5.7 Default values 

Go back to Default values in the Calculation parameters if needed. 

5.8 Compute/Cancel/Stop 

When the parameters are given, press Compute and start the calculation. 
If you want to go back to the map instead of starting a calculation, choose Cancel. 

5.9 Stop 

When a calculation is going on ‘Calculation status’ shows the hours where the 
program is. If you want to stop the calculation, press Cancel. 

5.10 Common Information 
Forecasted water temperature and salinity are taken from the Hiromb model and used 
for viscosity and evaporation. Density is calculated in Seatrack Web based on 
temperature and salinity. Turbulence is taken from the Hiromb model. 
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6 The calculation is ready 

 

Figure 6. Result showing that the oil stops at the coastline. 

Figure 6 is shown when a calculation is ready. It shows how the oil stops at the 
coastline and clearly shows the areas that are threatened. 

 

This scale, shown in lower right corner, gives information about the depth intervals 
where there is oil. Red is at the surface. Green is below the surface and less than 1 
meter depth. Yellow is deeper than 1 meter and less than 5 meters. And so on.  

6.1 Visualisation of the result 

 

These parts of the upper frame are active when a calculation is made.  

Trajectory  ON/OFF– draws a line through the centre positions of the spots every 
hour. To erase the trajectory click Trajectory  again. Time, date and position are 
written every 15 minute if there is space. If you then zoom, more data will be written.  
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Figure 7. Trajectory in a zoomed area. 

Trace ON/OFF and Animate – all the results from the forecast are shown 
automatically once an hour. To the left of Animate is Trace, which means that one 
sees every hourly spot in the same view. The hour of the animation is shown in the 
popup menu to the right. You can stop Animation by clicking Animate again. 

To look at each spot specifically use Start spot. Choose Step+1 to step 15 minutes in 
a forward calculation. The choice Step–1 steps one hour backward in a forward 
calculation. End spot gives the spot of the last time step. Simultaneously one can see 
the time of the actual spot in the popup menu and at ‘Now showing’ in the information 
square in the upper left corner of the map. The popup menu can be used instead of the 
steps. 

6.2 Plot the wind and the surface currents 

 

Show wind plots the 10 meter wind. In a zoomed area every 5th value is plotted. When 
you have the full map every arrow is plotted. The scale is given in the upper left corner 
of the map. Choose the time from which you want the plot. You can only look at a 
time covered by a made calculation. If you want to look at an earlier made saved 
calculation, then the data might be taken away and they can not be plotted. 
The wind can be animated when you animate the oil spill. Click ‘Show wind’ and 
click ‘Animate’. 

Show surface currents, plots the surface current, see figure 8. In a zoomed area every 
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5th value is plotted. The scale is given in the upper left corner of the map. 
The surface current can be animated when you animate the oil spill. Click ‘Show 
surface currents’ and click ‘Animate’. 

The ice can be animated when you animate the oil spill. Click ‘ Show ice’ and click 
‘Animate’ 

 

Figure 8. Surface currents in a zoomed area. The ice cover in the Riga Bay has a vital 
influence on the currents. 

6.3      Save a case 

Save Case- when you want to save a calculated case. When Save is done you choose 
the directory yourself.  
OBS: If you use Java 1.6 or higher you must add .xml suffix after the name of the 
file you want to save. If you use earlier Java versions you can add it if you want. 

6.4      Start a continued case 

 

This is chosen when one wants to make a continuation of an earlier made and saved 
calculation. One must open the earlier executed case if it is not just made and thus is in 
the computer. Open Case below File in the upper frame. Try to always save in a 
certain directory.  

Press Continued Case in the upper frame. Most of the information in the Calculation 
parameters is given from the earlier executed forecast in the saved case and can 
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therefore not be changed. If the result from an earlier made forecast is verified against 
observations and there is a discrepancy between the last calculated position and the 
observation, the starting position can be altered in Centre position by giving new 
Latitude and Longitude there. New Stop time must be given, as the forecast now is 
prolonged from the previous forecast. The start time of the Continued Case is the stop 
time of the previous case and the new stop time is by default one day further ahead. 
This can be altered. New Other info below Calculation info can be written. 

6.5 Print/plot the results 

File is shown in the upper frame. 
Save Map as image, save the map on the screen as jpg. 
Email map as image, mails the map. 

View is shown in the upper frame.  
Results table gives all the calculated data in ‘ready to make’ plots. 
One can see how big part of the oil that is stranded at the shore Oil at shore and how 
much that is on the sea bed Oil at sea bed. 

You can make a plot of the oil’s different states by marking the wanted variables and 
press Create chart down to the left. It is possible to plot the other variables such as 
viscosity and so on by clicking the wanted variables and press Create chart. Or make 
your own plot, by copying the table. 
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7 Support 

Calculation problems, customer relations 
Cecilia Ambjörn, Oceanographer, 011-4958174, 0709-784488. 
Email : Cecilia.Ambjorn@smhi.se 
 
System or installation problems 
Hans Andersson, Application Manager, 011-4958218 
Email :Hans.Andersson@smhi.se 
 
SMHI, 60176 Norrköping, Sweden 
Phone +46-11-4958000, Fax: +46-11-4958001 

8 Error and warning messages 

Error messages, are shown below the map in red letters. 

Err! 

• Internal input/output error 
• Invalid start or stop time 
• Forward/backward calculation inconsistent with start/stop time 
• Invalid start position  
• Invalid specification of outlet area 
• Outlet on land or outside model domain 
• Invalid substance value or unit  
• Substance not found in oil database 
• In the weathered state all of this volatile oil has evaporated 
• Invalid discharge value or unit  
• Invalid current options value or unit  
• Invalid calculation option  
• Backward calculation not possible for fresh oil 
• Continuous discharge not possible for weathered oil 
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• Calculation with floating object requires depth=0 
• Invalid input data  
• Substance outside boundary 
• Internal error 
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9 Annex 1 
AIS (Automatic Identification System) Shiptracks  

The AIS information is available when you are authorized by Helcom and 
implemented by the Seatrack Web administrator, SMHI, cecilia.ambjörn@smhi.se.  
Check this by looking in the File menu if Load AIS data is not shown, you have no 
access.  

9.1 Background 

The AIS functionality in Seatrack Web is a tool to identify the ship which causes an 
oil spill. The AIS function gives the shiptracks in the area where the spill was detected 
and backwards to its probable origin. By using the shiptracks simultaneously with the 
oiltracks the probability to indentify a suspected ship increases. 

9.2 Backward calculation from the detected spill site 

Before you can load AIS data you must have a calculated case(backwards) to work 
with. The case is created by making a Backward calculation where the positions of the 
spill are given by double-clicking in the map up to 4 corners.  
Choose New case and choose Backward calculation. Give the relevant Start and 
Stop time. Press Compute.  

Check that AIS data are available choose: View and Available AIS data files. It 
shows data 30 days back. 
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9.3 Load AIS data 

Go to the File menu and select Load AIS data.  

 

A pre-filled dialog appears. You can choose a size of the square relevant for the 
situation. 

 

Start time: Default time is the Start time of your Backward calculated case.  

Stop time: Default time is the Stop time of your Backward calculated case. This can 
be prolonged if wanted. If a long period is chosen it takes a very long time to collect 
data. Therefore less then 3 days is recommended. 

Size of area (n.m.): The search area is a square and it follows the centre point of the 
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moving oil slick.  
Deafult: 12 n.m. is plus/minus 6 n.m. around the centre point in all directions. Can be 
modified. 

Press OK  and retrieve AIS data. An information dialog showing that the system is 
active is now shown in upper right corner of the screen. 

9.4 Plot the ship tracks 

A dialog appears showing how many ship tracks that were found. If no ships are found 
make a larger search area or a larger time interval. If you still get no ships then AIS 
data is not available for this time or a problem has occurred. If you get hundreds of 
hits you must narrow the area or shorten the time interval.  

If data are missing, because of technical reasons please contact the SMHI. This shall 
not happen. 

In the figure there was 1 file missing of the 238 files (every 15 minute) in the area 
during the chosen time period. 

 

Press OK  and the ship tracks are shown on the screen. 

When searching for interesting ships, the backward oiltrack can be followed. 
Recommended is to step the spot every 15 minute. It can also be animated, but that is 
just to get an overview. 

The information covers the period between the chosen Start time  and Stop time and 
identifies all the ships that were inside the chosen yellow square. This square moves 
with the oil slick to show the ships that were in the vicinity of the oil. If the square is 
increased more ship tracks will turn up. 

Note: The chosen size of the square must be large enough so ships can not pass 
through the yellow search area. In that case ships might be missed. And small enough 
not to get too many ship tracks. 
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9.5 Working with the ship tracks 

 

Example of ship tracks and an oil spill. 

9.5.1 Ship tracks 

Ship tracks are drawn as lines with one small cross every 15 minute. That means that 
about every 2nd position from the AIS database (data exist every 6th minute) is plotted. 
If you zoom out, the crosses are not shown. If there are no crosses, zoom in and they 
will appear. 

The crosses are black or pink. If black then this point comes from real data. If pink 
then no information was available and the track is interpolated linearly between the 
previous real point and the next real point. AIS data are sometimes missing in some 
areas and then the analysis here are uncertain. In order to show data from the ship in 
the area anyhow, a track is interpolated. Interpolated track is dashed. 

Colour of a shiptrack is grey, black or red. Normally the colour is grey. The 
shiptrack becames black at the moment when the ship is close to the spill, at the time 
when the ship is inside a defined AIS search area presented with yellow on the screen. 
You may click a gray shiptrack once and the colour turns into red. Then you are able 
to see the time information at each cross. At the cross where the mouse is located 
when clicking at the line is also shown the position and MMSI number. See an 
example of a red shiptrack in the figure above. 

9.5.2 Search area 

You will see a yellow square around the centre point of the spill. This is the search 
area. It follows the spill if you step forward or backward or animate the spill.  
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9.5.3 Ships 

The position of the ship is drawn as a green triangle on the shiptrack. This symbol will 
move if you step forward or backward or animate the spill. When the ship is within the 
yellow search area the track is black and close to the spill at this time. 

9.5.4 Selecting shiptracks 

   Arrow tool  

First select the Arrow tool  in the menu furthest to the left. To show the time of a ship 
track, make one quick click on the track. A selected shiptrack is red, it is black if the 
ship is close to a spill. 

Normally time (hh:mm) is displayed every 15 minutes. If these texts are too close 
together then some will be hidden. Both date and time are shown for midnights (yyyy-
mm-dd hh:mm). When you click on a point using the arrow tool more information will 
be shown such as date, time, position and the ship’s MMSI number. This shows also 
when you click on an interpolated part of the track.  

9.5.5 Draw a line anywhere in the picture 

You can draw a line anywhere in the picture. Choose Draw lines. Keep the button 
down where the line shall start and during the whole line. The coordinates follow the 
mouse, so you can choose how to draw the line. The line is green in the application, 
see figure below. Take it away by activating the icon and double-click on the line. 
When you save a case the line is not saved. 
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9.5.6 Extra information 

Tracks with black crosses have more information about the ship in the track. 

Select the track you want more ship information about by clicking at a small cross and 
select View in the menu and Ship Info. Sometimes there is too little data, then go 
along the track and click on another cross. Then the dialog below comes up.  

 

When you choose Save info use the prefix .txt after the name of the file. 

9.5.7 Deleting shiptracks 

To remove a shiptrack from the screen, double-click on it. But to take away the right 
track, you have to double-click at a cross at the chosen track and have the very point of 
the arrow close to the cross, otherwise the wrong track might be deleted. If you want it 
back, go to the table AIS ships, click the line with the ship, it becomes blue, and press 
Delete/undelete in the left bottom, see figure below. 

You can also delete a ship track by taking it away in a table, where all ship tracks are 
shown. Go to View and AIS ships, press Delete/undelete in the AIS ships table. 
When deleted it is shown by YES in the first column in the table. 
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9.5.8 Explaination of the table Ships 

 

The small boxes below the table 
Delete/undelete a track, explained above.  
Save table, use the prefix .txt after the name.  
Press a line with a ship, it gets blue, then choose Ship info and that track becomes red 
in the map and the table Ship Info for that ship comes up.  

Edit ship track , (only for advanced users). This makes it possible to add data from the 
log book, when there is interpolated/no data in the AIS information. Interpolated data 
is shown in the table AIS signal with a No. Doubleclick on the position you want to 
change, the background becomes white. Write the new number. Press Enter. Press 
Save in the bottom of the table. The track is now altered in the map. 

 

Show track in map makes that track black in the map. It must then be marked as 
Undeleted in the first column. 
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The columns 
The first 5 columns, see head of column. 
The 6-7th column show the time a ship enters the search area, Entering area, and the 
time it leaves the search area, Exiting area. 

9.5.9 Delete case or AIS data 

You can delete the oil backtracking case and the AIS data, by clicking the cross in the 
upper frame: Delete case. 

Delete AIS data by clicking Clear AIS data 

9.5.10 To save a case and show it later in the STW application. 

Click Save Case below File, you choose the directory yourself. The name of the case 
must have suffix .xml if you have Java 1.6 or higher.  
This means that you can show this at any time, with animation of both AIS and the oil. 

9.5.10 To save a case and show it without the application 

If you want to save the case and show it at a later occasion and not in connection with 
the STW application. Then there is a soft ware called Snag-It which can be used. The 
case can be copied to a cd for example. 
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9.6 Tips and info 

Normally when analyzing a case you probably start at the located oil spill, and then 
step back in time and check and analyze all ships highlighted in black until ready. 

Make the search time as short as possible to reject ships that are not interesting. 

For example:  
If the oil spill covers a large area then the spill is at least X hours old. If information 
exists that the spill was not present at an earlier time then this time is the stop time. 
Ships passing this point before this time are not interesting. 

If a ship has been identified as a prime suspect at a certain time then it is possible to 
create a Forward case to see if the size of the spill will create a spill as the one found. 
Then momentaneous or continuous can be chosen. 

Depending on the length of the time period or uncertainty of the spills trajectory you 
may need to increase the search square to find the suspect. 

When analyzing it can be necessary to use a smaller square so you don’t miss fast 
going ships or catch ships that have been interpolated for a long time and therefore 
show an uncertain track. 

If you get quite a lot of hits when loading AIS data for a case you may decide to split 
the analysis in two (or more) parts. Set the time period to a smaller interval and do the 
analysis in separate steps instead. For example: Analyse the last day first and then the 
previous day after that separately. 

The system interpolates to fill in where the ships were between known positions. This 
works well if the AIS information is not lost for very long times. In that case the ships 
true course may differ from the interpolated track. 

A ship track may seem to start or stop in the middle of the sea. This is because of the 
chosen start and stop time. 

The position may be lost for some time at the end of the search period. Then the 
system has no chance to interpolate the positions at the end. In this case it is possible 
that the ship is not included in the search. 

The crosses on the ship tracks show the latest known 6 minute position each whole 15 
minutes. (This gives some uncertainty for the position along the track but this should 
not a big problem.)  
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10 Annex 2 
Satellite detections 

Satellite detections of oil spills - only for those having access to satellite data. You 
can choose a period (From-To) during which you want to see all detected oil spills. 
Press Search. Delete detections from map, takes away the detections. This is only 
available for users working with ‘finding illegal polluters’. 

Information about the satellite detections. 

 
Some satellite detections 

Locate show the spill in the map, ID  a STW number to identify the spill in the map, 
Confidence low, medium, high, Area (km2), Length (km) of spill, Satellite name, 
Observations time ( UTC). 
Exit  - close the application. 


